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iD22 is the culmination of years of 
experience in high-performance 
analogue and digital circuit design.

iD22 will transform your DAW into a 
world-class recording system by connecting 
directly to your microphones, computer 
and monitors.

iD22 provides two classic audient (class-a) 
microphone preamplifiers, ALL NEW pristine 
AD/DA converters that have been designed 
to deliver impeccable detail and impressive 
depth during both tracking & mixing. 

iD22 is expandable via ADAT i/o - perfect
for partnering with an ASP008 for 10-ch 
recording (total 10-in, 12-out + headphones). 

Our console-style monitor controller 
functionality and USB2.0 connectivity 
complete the ergonomic desktop package.

Features include:

•	 2-in, 6-out high performance 			 
24-bit/96kHz AD/DA converters

•	 2 x superb class-a mic preamplifiers 		
& 1 x discrete JFET instrument input

•	 Fully balanced insert points for 
integrating outboard gear

•	 High current headphone amplifier fed 		
by an independent DAC

•	 4 assignable line outputs for monitoring 
& processing	  

•	 User defined monitoring functionality 		
with hardware control

•	 USB2.0 class compliant connectivity 		
with integrated DSP mixer

•	 Ergonomic desktop package featuring all 
metal construction and solid aluminium 
control knobs

Welcome & Thank You

Thank you for purchasing
this audient product!
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Box Contents

In your iD22 packaging you should find the 

following items:

•	 iD22

•	 12VDC PSU with regional adapters

•	 USB Type A-to-B Cable

Please visit:

www.audient.com/products/iD22 

to download the latest iD software 

(firmware and mixer application), supporting 

documentation (including this manual) 

and brochures for our product range.

The 12VDC (centre-positive) power supply 

comes with interchangeable  UK, EU, US and 

Australian socket adapters and will work 

across a broad range of line voltages making

iD22 globally portable.

We hope that you enjoy using iD22

wherever you are and may it aid you in 

making great sounding music!

Actual PSU & USB cable may differ from images.

iD22 Overview
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http://www.audient.com/products/id22
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Important Safety Instructions

Please read all of these instructions and save them for later reference before connecting

the DC power adapter to the mains and powering up iD22.

To prevent electrical shock and fire hazard follow all instructions on the 12VDC power supply. 

iD22 itself does not operate with any high voltage mains supply inside the unit but appropriate 

safety measures should still be adhered to regarding the AC/DC supply.

In the event of a power supply failure do not open the 12VDC supply. Please contact audient 

support so that a suitable replacement can be recommended or purchased.

www.audient.com/support

iD22 utilises an external switch-mode power supply that is very quiet and rated at 1.5A 

(2A maximum, 24 Watts). This switch-mode design will accept any A.C line voltage from 

90v to 264v @ 47-63Hz. Therefore the unit will work happily anywhere in the world but 

please ensure your A.C mains line voltage is within this specification. 

Consult a qualified technician if you suspect difficulties. Do not attempt to tamper with the 

power supply or mains voltages - HAZARDOUS TO HEALTH. Ensure that the appropriate

international pin adapter is fitted to the power supply before insertion into the mains socket.

Safety Information

! WARNING !

TO REDUCE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS APPARATUS TO 

RAIN OR MOISTURE.

NO USER SERVICEABLE PARTS INSIDE. 

PLEASE REFER SERVICING TO  QUALIFIED SERVICE PERSONNEL.

Important Safety Instructions

1. 	 Read these instructions

2.	 Keep these instructions

3.	 Heed all warnings

4.	 Follow all instructions

5.	 Do not use this equipment near water

6.	 Clean only with dry cloth

7.	 Do not block any ventilation openings. Install in accordance with the manufacturer’s 

	 instructions

8.	 Do not install near any heat sources such as radiators, heat registers, stoves, or other 	

	 equipment (including amplifiers) that produce heat

9.	 Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized

	 plug has two blades with one wider than the other. A grounding type plug has two 	

	 blades and a third grounding prong. The wide blade or the third prong are provided for 	

	 your safety. If the provided plug does not fit into your outlet, consult an electrician for 	

	 replacement of the obsolete outlet

10.	 Protect power cords from being walked on or pinched particularly at plugs, 

	 convenience	 receptacles, and the point where they exit from the equipment

11.	 Only use attachments/accessories specified by the manufacturer

12.	 For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, 	

	 or table specified by the manufacturer, or sold with the equipment. When a cart is 	

	 used, use caution when moving the cart/equipment combination to avoid injury from 	

	 tip-over

13.	 Unplug this equipment during lightning storms or when unused for long periods of time

14.	 Refer all servicing to qualified service personnel. Servicing is required when the 

	 equipment has been damaged in any way, such as power-supply cord or plug is 

	 damaged, liquid has been spilled or objects have fallen into the equipment, the

	 equipment has been exposed to rain or moisture, does not operate normally, 

	 or has been dropped

15.	 For products that are a mains powered device: The equipment shall not be exposed

	 to dripping or splashing and no objects filled with liquids (such as vases) shall be

	 placed on the equipment

Safety Information

http://www.audient.com/support
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FCC Part 15B

This apparatus has been tested and found to comply with the limits of a class-a digital device, 

pursuant to Part 15B of the FCC Rules. These limits are designed to provide reasonable

protection against harmful interference in a residential installation. This equipment generates, 

uses and can radiate radio frequency energy and, if not installed and used in accordance with 

the instructions, may cause harmful interference to radio communications. If this equipment 

does cause harmful interference to radio or television reception, which can be determined by 

turning the equipment off and on, the user is encouraged to try to correct the interference by 

one or more of the following measures:

	 1.	 Re-orient or relocate the receiving antenna

	 2. 	 Increase the separation between the equipment and receiver

	 3. 	 Connect the equipment into an outlet on a different circuit from that 

		  to which the receiver is connected

	 4.	 Consult the dealer or an experienced radio/TV technician for help

Declaration of Conformities

		  We, Audient Ltd, Aspect House, Herriard, Hampshire, RG25 2PN, UK, 
		  01256 381944, declare under our sole responsibility that the product iD22 
		  complies with Part 15 of FCC Rules. 

		  Operation is subject to the following two conditions:

		  1. 	 This device may not cause harmful interference, and
		  2. 	 This device must accept any interference received,

			   including interference that may cause undesired operation

		  Audient Ltd has conformed where applicable,to the European Union’s Directive 			
		  2002/95/EC on Restrictions of Hazardous Substances (RoHS) as well as the 
		  following sections of California law which refer to RoHS, namely sections 25214.10, 		
		  25214.10.2, and 58012, Health and Safety Code; Section 42475.2, Public Resources

		  We, Audient Ltd, declare that the product, the iD22, to which this declaration 
		  relates, is in material conformity with the appropriate CE standards and directives
		  for an audio product designed for consumer use.

Quick Start Installation

System Requirements

•	 OSX: 10.6.8 or later (Snow Leopard+)

•	 Mac: Intel CPU, 1GB RAM Minimum

1. Download the Latest iD Software

Head straight to our website for the latest 

version of our iD mixer application:

http://audient.com/products/downloads/iD22

Run the installer and follow the on-screen

instructions. It is recommended that you 

restart your computer after installation 

to allow all settings to take affect.

2. Connect iD22

Using the USB cable provided, connect 

iD22 to your computer’s USB port.

Next power on iD22 by connecting 

the supplied 12VDC power adapter.

USB

http://audient.com/products/downloads/id22
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Quick Start Installation

3. Status LED

Once powered on and connected to your 

computer via USB, the green status LED on 

iD22 will flash for a few seconds as the unit 

stabilises and establishes communications.

This LED will become solidly lit as soon 

as iD22 has achieved stable communication 

and should remain solidly lit during operation 

of the unit until power down. Once solidly lit 

you can launch the iD mixer application 

without issue.

If at any time the status LED begins to flash 

during normal operation please check all 

connections and if further problems develop 

please contact audient support.

4. Double Checking Connectivity 

To ensure iD22 has been detected by your

computer and correct clocking sources are 

set-up, navigate to:

Macintosh HD > Applications > 

System Preferences

Check that iD22 is set as your i/o device.

It is recommended to disable system sounds.

It is also worth checking Audio MIDI Setup

(found in Mac HD > Applications > Utilities).

Window > Show Audio Window

Here you should see iD22 report with 10 

inputs and 14 outputs. Clock source should 

be set to Audient Internal Clock unless you 

are connecting an external digital device 

acting as master to the digital input in iD22.

Quick Start Installation

5. Launch the iD Mixer Application

Launch the iD22 mixer application

by finding it in the following folder:

Macintosh HD > Applications > iD22

If the iD mixer application icon is not in 

your dock, just drag it onto the dock from 

the applications folder.

For more information on the mixer 

application feature set, please refer to 

page 20 of this manual onwards.

6. Check for Firmware Updates

It is essential that you regularly (especially on 

a fresh installation) check for new updates.

To make it simple, providing you have an 

internet connection, the iD mixer application 

itself provides the functionality to check for 

firmware updates.

7. Firmware Update

You can either select to update the iD

firmware from disk using the load from

file (browse button) or you can use the 

internet to search for the latest version.

The latest version number will be retrieved

from our servers and will be displayed (as 

shown above). Press next to continue with 

the firmware update. Press update to 

program and once complete close the 

window. iD22 is now ready to use.

 

http://www.audient.com/support
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Hardware Features

Microphone Preamplifiers
& Line Inputs

iD22 features two classic audient 

microphone preamplifiers.

The design features an 8-transistor

discrete class-a front-end providing

exceedingly low distortion and noise 

performance. From a sonic point of 

view, iD22 is fast, open and detailed.

All analogue circuitry runs on +/-15V

(30V rails) and provides high headroom

and class leading drive capability compared

to other similar interface products.

The microphone preamplifiers feature:

•	 60 dB of clean gain

•	 48v phantom power rated at 10mA/		

channel

•	 > 3kΩ input impedance which provides 

a punchy tone from any microphone      

transducer type

•	 -10 dB pad for increasing input headroom

•	 Polarity reverse (always check 

phase when recording with multiple                                            

microphones)

•	 Switchable (fixed frequency) 100Hz        

12 dB/octave high pass filter for rumble 

removal

NeutrikTM XLR/TRS Jack combi-connectors 

provide microphone and line inputs. The line 

inputs are padded through the microphone 

preamplfiiers and have access to the pad, 

polarity reverse & HPF functions, therefore 

accommodating a huge range of input levels 

with freedom from overload.

Hardware Features

Instrument Input

iD22 employs a discrete class-a JFET

instrument (D.I) input on channel two.

Plugging in a TS (tip-sleeve unbalanced)

jack will override the mic signal and turn 

channel two into a fully fledged, fantastic 

sounding instrument input with access to a 

-10 dB pad (for hot output instruments such 

as active basses, drum machines and 

synthesizers), polarity reverse (useful for 

phase alignment between a mic and D.I) and 

the HPF (useful for taming unruly low 

frequency content).

Balanced Inserts Send & Return

Once signal has passed through the 

microphone preamplifier and input 

conditioning stage - it is provided at 

a balanced insert send jack. 

Both input channels feature impedance 

balanced insert sends and electronically

balanced insert returns before the AD 

converter.

These console-style insert points make it 

very easy to add your favourite processing 

prior to conversion - setting iD22 apart from 

much of the competition.

Insert your favourite compression and EQ 

here to build vocal chains that rival the very 

best. Rest assured the mic pre in iD22 will 

stand up to many outboard units costing 

several times more than the entire unit!

Insert Normalling

Insert send & return jacks use normalling 

connectors and therefore do not need to be 

patched when not in use. 

Capture great tone

just by plugging in direct! 
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Hardware Features

Patching Inserts

To incorporate your favourite

processing prior to conversion, simply 

patch the iD22 insert send into your 

processing chain and take the output 

of the last device in the chain and patch 

back into the insert return on iD22.

Direct Access to ADC

The insert return connection on iD22 is a 

very pure electronically balanced input stage 

that directly drives the analogue to digital 

converter stage (ADC).

As such this is a great place to return

signals directly into the ADC ensuring

minimal signal path colouration.

Calibration Level: 0dBFS = +18dBu

This is a great place to patch the outputs

of your existing outboard mic pres or indeed 

to  bypass the iD22 mic pres and use as a 

very pure unity gain line level ADC input for 

incorporating hardware inserts or using a

mastering style process path.

Great for using DAC outputs 3+4 to drive a 

hardware mix bus compressor and printing

back via the pure signal path of the insert 

returns.

iD22 Microphone 

Preamplifier

Insert

Send

Processing Chain

Insert Returns = 

Line Level ADC Inputs

Input Stage Block Diagram
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Hardware Features

Assignable Line Outputs & DACs

iD22 features four assignable line / DAC 

outputs. These can be used to create many

useful routing options for both tracking and 

mixing.

Output assigns take place in the iD mixer 

application System Panel (see page 27 for 

details accessed in the Master Section).

Here a selection of radio buttons allow

outputs to be fed from either the iD DSP

mixer main output, the iD mixer cue outputs 

(A or B), an alternative loudspeaker output 

or directly from your DAW (bypassing the iD 

DSP mixer by paralleling the input straight to 

the DACs).

Typical Output Routing

In traditional style tracking situations with 

separate engineer and artist(s) mixes, 

outputs 1+2 would likely be set to Main Mix 

to provide output to control room speakers. 

Outputs 3+4 can be set to feed a cue 

mix (from Cue A or B) to external headphone 

amplifiers in either ganged stereo or dual 

mono.

iD22’s built in headphone output (5+6) could 

be used as a 2nd reference for the engineer 

(set to monitor the Main Mix) or as an 

alternative and independent headphone mix 

for an artist (set to Cue A or B).

If you prefer to balance all headphone mixes 

from inside your DAW (at low buffer sizes to 

minimise latency) then selecting DAW Mix 

for outputs 3+4 and 5+6 would allow your 

DAW to directly address the DA converters 

and outputs without passing through the iD

DSP mixer (note the mixer is still active).

In traditional mixing situations, outputs

1+2 would be set to monitor the Main 

Mix (taking advantage of the DSP monitor 

controller functionality in iD22. Outputs 3+4 

can be set-up as an alternative speaker 

destination (main/mini etc) and headphones 

(5+6) can also be fed for reference.

Hardware Features

DAC & Line Output Routing Ideas

iD22 provides some very flexible output 

routing and these are best demonstrated

in diagram form. 

Using iD22 for Monitoring & Tracking:

Using iD22 for Mixing & Alt. Monitoring:

All four line outputs are electronically

balanced using the same topology as our

famous console, the ASP8024. 

Expect plenty of output drive (>18 dBu), 

good noise rejection and a balanced output 

impedance of <100Ω.

Using iD22 with Hardware Process Path:

Analogue 

Process Path
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Hardware Features

Headphone Output

iD22 features a high current headphone 

amplifier which is fed by it’s own separate 

DAC. This can be used for reference 

monitoring, to provide artist headphone mix 

or to drive a small set of loudspeakers from  

an unbalanced Y-split cable.

The headphone amplifier can be fed from a 

number of sources as set in the Routing 

Matrix found in the System Panel of the 

iD mixer application (see previous pages 

or the section found on page 27 for more 

info).

A front panel potentiometer provides

digitally calibrated and perfectly matched

stereo volume control over the headphone

output.

Digital Inputs / Outputs

To complete the i/o package, iD22 

features an optical input and output 

connection. These can be set to operate as 

stereo optical S/PDIF or 8-channel ADAT 

via the System Panel in the iD mixer 

application. Both formats will operate at up 

to 96kHz sample rate, with ADAT dropping 

to  4-channels at rates above 48kHz.

Running in S/PDIF mode, the optical i/o

provides the option to integrate an audient 

MiCOTM for 4-channels of audient micpre, or 

an external reverb for monitoring.

Running in ADAT mode, the optical i/o

provides a great way to expand to 10-inputs

via an audient ASP008TM for recording. 

The ADAT outputs could also be connected 

to headphone distribution systems such as 

a HearbackTM HUB or to an 8-channel DAC 

for summing purposes. We designed iD22 

to grow with your needs.

For more information about setting up 

sample rates and system clocking please

refer to pages 25 and 31 onwards.

Hardware Features

Example Output Routings - iD Mixer

Using iD22 for Monitoring & Tracking:

•	 Outputs 1+2: 	 Main Mix to C/R

•	 Output 3: 	 Mono Cue Mix A

•	 Output 4:		 Mono Cue Mix B

•	 Outputs 5+6	 Phones Cue Mix A

Using iD22 with ITB Headphone Mixes

(send DAW headphone mix to iD22 3+4):

•	 Outputs 1+2: 	 Main Mix to C/R

•	 Outputs 3+4:	 DAW Mix (ITB Phones)

•	 Outputs 5+6	 Main Mix (Engineer)

Using iD22 for Mixing & Alt. Monitoring:

•	 Outputs 1+2: 	 Main Mix to C/R

•	 Outputs 3+4: 	 Alt. Loudspeaker

•	 Outputs 5+6	 Headphone Reference

Using iD22 with Hardware Process Path

(bypassing iD mixer & monitor controller, 

using with existing analogue monitor

control):

•	 Outputs 1+2: 	 DAW Mix (Direct)

•	 Outputs 3+4:	 DAW Mix (To Outboard)

•	 Outputs 5+6	 Headphone Reference

•	 Outboard sent back to Insert Returns
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Hardware Features

Monitor Control

iD22 provides all of the excellent

monitor control functionality as found

on one of our consoles. 

As such, it is possible to control main and 

alternative loudspeaker volumes with

a perfectly matched stereo volume control

on the main unit. 

The MONITOR knob is solid aluminium and 

feels expensive - which is just the way it 

should be when you will touch it every day.

There is no signal degradation in this

volume control and stereo image will

not wander about at various listening 

levels - the image will be rock solid.

Accompanied by this monitor volume knob 

are permanently assigned hardware DIM & 

CUT switches. 

The level of DIM and ALT. Loudspeaker trim 

can be adjusted in the iD mixer application

(System Panel).

Alongside these functions, three user 

programmable ‘F’ keys provide access

to several useful monitoring features.

Monitor Control Features

•	 Volume control (perfectly matched)

•	 Alt. Loudspeaker with programmable 

level (assignable to an ‘F’ key)

•	 DIM with programmable level

•	 CUT

•	 Mono Sum (assignable to an ‘F’ key)

•	 Polarity reverse (assignable to an ‘F’ key)

•	 Talkback (assignable to an ‘F’ key)

By using polarity reverse and mono sum

it is possible to listen in sum or difference 

(mid or side) modes. This provides an 

excellent way to check mono compatibility 

and to also learn spatial tricks from your

favourite reference material. Please see 

this audient blog for more information on 

sum & difference monitoring:

http://blog.audient.com/

post/29826572065/sumdifference

Hardware Features

Hardware Metering

4-segment hardware LED metering

can be found on the main panel of

iD22.

This meter is peak reading and calibrated

to the digital recording medium.

iD22 converters use a standard calibration 

level of 0dBu = -18dBFS, or perhaps more 

importantly +18 dBu = 0dBFS.

It is suggested that end users observe

their DAW metering for recording levels,

hence currently the iD22 hardware meters

indicate playback level in the main mix

bus of the iD mixer application.

Status LED

The status LED indicates connection via

USB to your computer. Please see page

7 for more information.

Switch Operation

All hardware push switches (DIM, CUT etc)

feature momentary operation if pressed and 

held or latching operation if pressed and 

released quickly - very useful!

Kensington Lock

For those of you who work in educational

establishments or in situations where your 

equipment is public facing and subject to 

possible theft opportunities, we have added

a Kensington lock hole to the chassis to 

enable you to protect your iD22.

*Lock not included

http://blog.audient.com/post/29826572065/sumdifference
http://blog.audient.com/post/29826572065/sumdifference
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Output Stage Block Diagram Software Features

Input Channels - Channel Types

The iD mixer application features three 

types of input channels, these are colour 

coded and are as follows:

•	 Analogue (Inputs 1+2) - BLUE

•	 Digital (S/PDIF or ADAT) - GREEN

•	 DAW Mixes (Playback 1-6) - PURPLE

Analogue input channels are taken 

directly from the two ADC (insert returns,)  

signals available here are; microphone, line, 

D.I (channel two) or unity gain line input at 

the return jack.

Digital inputs are provided as two 

channels in S/PDIF mode and eight 

channels in ADAT mode (four at > 48kHz).

DAW inputs are provided as three stereo 

pairs and are designed as ‘virtual’ playback 

channels from your DAW.

These can be monitored via the onboard

DSP mixer, routed to cue mixes or hard 

assigned to DAC outputs. 

Addressing outputs in your DAW will feed 

signals into these channels. Therefore iD22 

can sum all three signals together for 

monitoring and access to cue mix buses.

Channel Naming Strip

Harking back to our large format console

heritage - the iD mixer application allows 

you to label your channels via the editable

marker pen text on console tape!

MIC/LINE 1 or KICK for example
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Software Features

Stereo Linking

All channels can be linked or un-linked for 

stereo or mono operation. Level controls 

are ganged in stereo operation but stereo 

panoramic positioning control remains 

individual for left and right channels.

Useful Functionality

Every active control 

(buttons, pots or 

faders) in the iD mixer 

application feature 

colour coded mouse 

over indicators to help 

you quickly navigate 

and make adjustments.

All controls are also

scroll-wheel enabled in

the iD mixer application.

Channel Strip Controls

•	 Unlinked

•	 Individual Level

•	 Individual Pan

•	 Linked

•	 Ganged Level

•	 Individual Pan

Cue A Send Controls
Level (0 dB to off)
Pan (if using stereo cue)

Alt (⌥) + click to zero

Cue B Send Controls
Level (0 dB to off)
Pan (if using stereo cue)

Alt (⌥) + click to zero

Parameter Info Box
Normally displays main 
channel pan value but
if you hover the mouse
over any control - it will
display that parameter’s
value so you can see
what’s what

Channel Solo & Cut
Latching operation

Command (⌘) + click
on a solo switch, while on 
an un-solo’d channel will 
override any previously
solo’d channel

Command (⌘) + click
on an already activated 
solo switch will clear all
solo’d channels

Channel Meter
66dB Range
Separate Peak Hold Indicator
Click on peak indicator to clear
Alt (⌥) + click to clear all

Channel Fader
+6dB to off
Alt (⌥) + click to zero

Channel Tape Label
EDITABLE  - 8 characters

Master Section

Software Features

Cue Masters
Level (0 dB to off)
Controls output level
of all summed cue sends

Alt (⌥) + click to zero

Cue Master Solos
Use these cue solos
to audition artist mixes
quickly. They operate in
a interlocked fashion so 
only one can be solo’d at
a time

Talkback Button
Operating the talkback 
switch routes whichever 
input has been selected as
talkback (in system panel)
to both cue A & B (level set
by talkback channel cue
send levels) and to your 
DAW. This way talkback 
can be sent directly to 
artists or via the DAW to a 
record enabled or input
monitored track (SLATE 
mode)

Monitor Dim & Cut Buttons
DIM auto-triggered by 
talkback. Level programmed 
in system panel. 
Permanently controlled by 
hardware switches

Channel View Buttons
Customise your mixer 
layout by including only the 
channels you are using

Not using the digital i/o?
Hide it

Mixing / listening back and  
want to hide most of the 
GUI? You can

Show / hide when required

Main Meters
66 dB Range

These meters indicate the 
output levels of the DSP mix 

bus within iD22. They are 
mirrored by the 4-segment 

hardware LED meters on the 
main unit

1dB steps from 0 to-6dBFS
2dB steps from -8 to -56dBFS

Separate Peak Hold Indicator
Click on peak indicator to clear

Alt (⌥) + click peak to clear

System Panel Button
Opens the iD22  set-up and 

routing matrix panel
(see page 27)

Mono Sum Button
Monitor the output

of the iD22 DSP mixer
summed to mono

Assign to ‘F’ key > right click &
select F1, F2 or F3 

Polarity Reverse Button
Invert polarity of one side

of the stereo monitor output
for stereo difference checks

Assign to ‘F’ key > right click & 
select F1, F2 or F3 

Hardware Volume  
Control Only 

Alt. Loudspeaker Button
Switch to alternative 

monitors if set-up in system 
panel matrix as out 3+4

Assign to ‘F’ key > right click & 
select F1, F2 or F3 



23 24

Channel View Settings

When tracking (without using a digitally 

expanded iD22) it is most likely that the 

following channel view (Analogue + DAW) 

would be the most useful, enabling you to 

see mic/line inputs and DAW returns:

			   For simple monitoring / 		

			   listening or ITB mixing it 		

			   may be cleaner to view 

			   just the master section.

			   Or when fully expanded 		

			   via ADAT with something

			   like an ASP008, you can

			   view all channels (after 		

			   10 mono slots, a scroll 		

			   bar appears). 

			   View Mode Shortcuts:

			   Command (⌘) + 1 = Mic/Line

			   Command (⌘) + 2 = Digital

			   Command (⌘) + 3 = DAW Mixes

			   Command (⌘) + 4 = System Panel

Volume Control

The output of the iD DSP mix bus is sent 

to whichever output is set-up as Main Mix 

in the Routing Matrix. This is your monitor 

destination and should be connected to 

your main studio loudspeakers.

To control the monitor volume of this 

output, use the hardware knob on the 

main unit. 

			 

Software Features

Programming ‘F’ Keys
(Monitor Control Functionality)

There are several functions that can be

assigned to the hardware ‘F’ keys.

∑	 Mono Sum

In order to check your mix for mono 

compatibility (still important for DAB

radio and laptop / ipad users) either use 

the Mono Sum button in the iD software 

or assign it to an ‘F’ key by right clicking.

	 Polarity Reverse

By pressing the polarity reverse button,

the left channel of the stereo mix is 

inverted. When combining this with the 

right channel using the mono sum feature 

in conjunction with the polarity reverse

function - a L-R sum is created instead of an 

L+R sum. This will cancel the centre (sum) 

of the stereo signal and leave behind the 

difference signal (L-R). Monitoring this 

provides a great way to listen to stereo 

content such as reverbs and also pick up 

tricks from your favourite mix engineers.

It is a very useful and different perspective

of the mix balance.

Talkback - see page 26 for more 

information.

ALT	 Alternative Loudspeaker

To set-up an alternative loudspeaker

for greater monitoring flexibility - a pair of 

outputs must be assigned as a source to 

the alternative pair in the System Panel.

These outputs can be digital via S/PDIF or 

ADAT or indeed analogue via DAC3+4 or 

DAC5+6.

ALT can be used to turn on headphones 

if DAC5+6 is selected as the headphone 

source, alternatively you can feed loud-

speakers with DSP control and digital inputs 

via optical S/PDIF. 

However in most standard set-ups, 

DAC3+4 would be the most likely source.

Software Features
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System Panel

To open the system panel, press the 

SYSTEM button found in the master

section or use Command (⌘) + 4.

The full system panel contains two

sections:

•	 Setup Strip

•	 Routing Matrix

Setup Strip

Software Features

Digital Input Format
Select 8-ch ADAT or 2-ch 

S/PDIF input modes for 
the optical input here.

ADAT 8-ch 44.1 - 48kHz, 
4-ch 88.2kHz - 96kHz.
S/PDIF 2-ch all rates

Digital Output Format
Select 8-ch ADAT or 2-ch 

S/PDIF input modes for 
the optical output here.

ADAT 8-ch 44.1 - 48kHz, 
4-ch 88.2kHz - 96kHz.
S/PDIF 2-ch all rates

Clock Source
Select internal or optical input 

as the clock source. Ensure 
all sample rates match your 

DAW session and settings in 
Audio MIDI Setup on OSX

Lock LED
Indicates a valid external clock 

source. Red indicator means 
you have a clocking issue and 

should check source device

Talkback Assign
Select any available iD22

input (analogue or digital) to 
be the source for talkback 

as routed to cues. Mixer 
channel becomes talkback  
with no feedback possibility

Mono Mode
Set whether sum-to-mono

creates a mono sum in one 
loudspeaker (one acoustic 

source) or creates a ‘phantom 
centre’ sum (two acoustic 

sources) - they sound different

DIM & ALT Trims
Set DIM level:

0  to -30 dB

Set ALT loudspeaker level:
+/-15 dB

Assigning Talkback

When a channel is assigned as talkback 

source in the iD mixer application system 

panel, the equivalent mixer channel strip 

updates to become a talkback channel.

Channels will be presented in the talkback

assign menu as per their labelling in the 

mixer scribble (console tape) strip. As such

they are easy to identify.

No talkback microphone has been included 

within iD22 as these small electret 

contact microphone often pickup lots of 

switch press and handling noise. For many 

who record vocalists, one input for the 

artist will be enough so we suggest using 

a talkback microphone in Input 2, however 

any of the digital inputs could also be used.

Gooseneck Microphone Use

If recording a vocalist or 

drummer (with ASP008 

expansion) one microphone 

channel on the 

iD22 provides 

the perfect place 

to use a gooseneck 

talkback microphone to facilitate 

desktop communication & monitor control.

Talkback Channel Strip

When an assigned channel 

converts to talkback operation,

cue A & B send level and pan

remain, allowing you to route

talkback signal to artists via

the cue mixes. A channel info

box shows adjusted parameter

values and a routing box shows

which active channel is set as

talkback.

A secondary talkback button

is located on the talkback

channel which can be used

to trigger talkback whilst

setting up the software mixer.

You can assign the talkback

switch to an ‘F’ key in the 

master section.

Software Features
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Output Routing Matrix

The routing matrix allows you to patch 

the following iD DSP mixer outputs to the 

physical DAC outputs (1-6) or the optical 

digital outputs (1-8 in ADAT mode or 1-2 

in S/PDIF mode).

In the above example, DAC outputs 1+2 

are setup as a stereo pair fed from the iD 

DSP mixer main output. This is the default 

main monitor path and would feed your 

loudspeakers. The iD mixer main output 

passes through all monitor control 

functionality (mono sum, polarity reverse, 

dim, cut and monitor volume). 

DAC outputs 3+4 are set as two mono 

paths and fed individually by mono Cue A 

and B mixes. In this scenario note that cue 

pans controls have no effect

(cue masters are mono summed prior to 

routing to the DAC outputs). This would 

be used to feed an external headphone   

amplifier to provide two mono artist mixes. 

Naturally a stereo cue mix could be created 

by clicking on the stereo/mono path button 

and selecting Cue A or B as a source. 

Note the flexibilty here, as a stereo Cue A 

mix is feeding the iD22 headphone output 

(DAC 5+6). Alternative speakers can also 

be set-up here (typically DAC 3+4).  

By selecting DAW Mix the iD DSP mixer is 

bypassed and signals are effectively ‘hard-

wired’ from DAW to DAC.

Software Features

Stereo or Mono
Path Link Button

Output Sources from either 
DSP mixer or DAW direct 

(mixer bypass)

Output Destinations
Analogue / Digital

Headphones are
always stereo (5+6)

Saving & Loading Mixer Presets

Mixer presets can be saved and loaded in 

two ways:

•	 Using the buttons at the bottom of the 

system panel

•	 Using standard keyboard shortcuts  

•	 Save:	 Command (⌘) + S

•	 Load:	 Command (⌘) + O

Saving a Mixer Configuration

Presets can be named when saving

from within the system panel, just 

double click the name box to add.

Normally presets are saved in the following 

location: Macintosh HD > User > Library 

> Application Support > Audient > iD22 > 

Presets

However by using the 

browse button you can 

save preset files to 

whichever folder you desire - allowing you 

to contain them within your DAW session 

folder for example (making recall easier).

Loading a Mixer Configuration

Loading a preset is very simple, just click 

on the load button in the System Panel and 

select one of your previously named files, 

double clicking will also load a preset. To 

rename a preset, click to highlight and then 

after a pause, click again to rename. To 

delete, click to highlight and then click on 

the X (delete) button at the bottom.

Software Features
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DSP Mixer Block Diagram Keyboard Shortcuts

Keyboard Shortcut Index

To allow you to find all shortcuts for the 

mixer application in one place without 

having to go through each page of this 

manual please refer to this table:

Location		  Shortcut			   Description

		

Faders		  Alt (⌥) + Click		  Resets fader to unity gain (0 dB)

Pans			   Alt (⌥) + Click		  Resets pan pots to central position	

Solos			  Command (⌘) + Click	 Clears all solos if clicking on a solo’d channel

							       Overrides all other solos (for solo exclusive)		

							       if clicking on an unsolo’d channel

Meters		  Alt (⌥) + Click		  Clicking on peak hold indicator will clear all clip

							       indicators

System Panel	 Command (⌘) + S	 Save mixer configuration

			   Command (⌘) + O	 Load mixer configuration

View Modes		 Command (⌘) + 1	 View Mic/Line Inputs

			   Command (⌘) + 2	 View Optical (Digital) Inputs

			   Command (⌘) + 3	 View DAW Mix Inputs

			   Command (⌘) + 4	 View System Panel

Please check the iD22 page online at www.audient.com/iD22 
for the latest mixer application updates. 

More shortcuts may be added without notification.

http://www.audient.com/iD22
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Pro Tools Set-up

Operation with Pro Tools

Once iD22 has been successfully installed

following the steps detailed on page 6 of 

this manual, launch Pro Tools and ensure 

that a new session is created at the desired 

sample rate (if clocking internally) or at 

the rate of the clock source (if clocking 

externally).

Playback Engine

Go to Setup > Playback Engine... and ensure 

that iD22 is set as the active playback

device. Appropriate buffer sizes can also be

set here. Please bear in mind that Pro Tools 

will reboot if the playback device is changed.

For more Pro Tools information consult 

your Avid user manuals & documentation.

Go to Setup > I/O... to label your inputs and 

outputs and ensure that iD22 is correctly 

reporting 10-inputs and 14-outputs to and 

from Pro Tools. Note that analogue outputs 

1-6 are in fact the DAW virtual playback 

channels in the iD DSP mixer and can 

either be routed through the iD mixer or 

hard-wired directly from Pro Tools to the 

DAC stages. 

Logic Pro Set-up

Operation with Logic Pro

Once iD22 has been successfully installed 

following the steps detailed on page 6 of 

this manual, launch Logic Pro and check the 

following:

Logic Pro > Preferences > Audio

Ensure that iD22 is selected as the active

audio device and here you can set buffer 

sizes to affect system latency. If you are    

experiencing issues with playback stability 

and CPU loading, try increasing the buffer 

size to > 256 samples.

If you are using iD22’s onboard DSP mixer 

to monitor input signals while recording, be 

sure to disable Logic’s software monitoring 

to avoid phasing as the same source will 

be heard twice with a short delay between 

the low latency DSP signal and the delayed 

software monitoring signal.

Assigning i/o

All of iD22’s input and output channels will 

be available to Logic for routing. There are 

a total of 10-inputs and 14-outputs 

reported from the driver.

You can rename input 

and output channels to 

whatever you wish using 

the I/O label function. 

This is a great way to 

keep things organised.

Options > Audio > I/O Labels
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Logic Pro Set-up

Operation with Logic Pro

If you are using an external clock source

(ADAT or S/PDIF) to clock iD22, please 

ensure that Logic Pro is set to the same 

sample rate when recording and playing

back in a session, otherwise things may 

sound a bit sharp or flat!

Settings > Audio > Sample Rate

If you are using internal clock on iD22,

setting the sample rate via Logic Pro will 

update the iD22 sample rate to follow your 

session.

There may be a slight pause as the system

re-clocks. This is normal.

This can be verified in Audio MIDI Setup.

Macintosh HD > Applications > Utilities

For more Logic Pro information please 

consult your Apple user manuals & 

documentation.

Cubase / Nuendo Set-Up

Operation with Cubase / Nuendo

Once iD22 has been successfully installed 

following the steps detailed on page 6 of 

this manual, launch Cubase or Nuendo and 

head straight for the Devices menu:

Devices > Device Setup...

Select VST Audio System in the devices 

menu.

Select Audient iD22 in the menu to ensure 

that Cubase / Nuendo addresses the iD22 

device driver. You will be asked if this is OK, 

select ‘switch’.

Select Audient iD22 in the devices menu...

Here you will see the 

main iD22 information,

where clock sources

can be set as well as 

activating i/o ports.

Be sure to click 

Externally Clocked if 

clocking from another

digital device via ADAT / SPDIF.
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Cubase / Nuendo Set-Up

Operation with Cubase / Nuendo

Buffer sizes can be set in the control panel

within the VST devices display. It would be

ideal to keep them quite high to reduce CPU 

loading if you use the iD22 mixer as the 

input monitoring device while recording.

I/O ports can be renamed in the device

panel such that they better represent what 

you connect to them (for example Main 

Monitors, Alt. Monitors, Hardware Process

Loop). This is useful as any names chosen 

here will be those displayed when assigning 

i/o on track input/output channel routing.

Close the VST device setup panel and 

navigate to the VST connections panel:

Devices > VST Connections (F4)

Here you can ensure that all buses have 

been created in Cubase / Nuendo and 

therefore all ports are addressable in your 

session. Add new buses and assign them 

to the necessary i/o if required.

Bus types can be set (mono / stereo) and 

the VST control room section can also be 

used. For more information regarding set-

up please consult your Steinberg user 

manuals and documentation.

Ableton Live Set-up

Operation with Ableton Live

Once iD22 has been successfully installed 

following the steps detailed on page 6 of 

this manual, launch Ableton Live and head 

straight to:

Live > Preferences

Here navigate to the Audio tab and make 

sure that iD22 is assigned as the playback

device.

			 

			 

			   For more information 		

			   about setting up audio 

			   i/o refer to your Ableton 	

			   Live user manuals &

			   documentation.

In the Live Audio Preference panel you can 

set an appropriate buffer size (this can be 

kept high if you are monitoring input signals 

for recording via the iD22 low latency DSP 

mixer. Ensure that iD22 reports as a 10-in, 

14-out device to Live. 

If necessary you can limit the number of 

i/o channels reported as active inputs 

(from the driver) in Live by using the input 

and output config tabs. This is an excellent 

feature to help reduce CPU loading if all 

channels are not required.
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Troubleshooting & FAQ

Troubleshooting

•	 The unit will not power on:

Double check the 12VDC power supply is 

plugged into iD22 and into an operational 

mains wall outlet.

To verify the supply is functional, use a 

multimeter (set to volts DC) and safely 

measure output DC voltage between 

centre pin and shield of DC output 

connector, it should be 12VDC +/-0.5V) 

AT NO TIME SHOULD UNQUALIFIED 

PERSONNEL ATTEMPT TO MEASURE 

MAINS VOLTAGES OR INTERNAL 

SWITCHING SUPPLY VOLTAGES

•	 When I connect to my computer,             

I cannot play any audio out from iD22:

Firstly double check that the USB cable 

connecting iD22 to your computer is

functional and attached at both ends.

Launch the iD22 mixer application to 

activate communication between your 

computer and iD22. This only needs to be 

done once straight after power up. Once 

iD22 is set to the operational state you 

desire, you can quit the iD22 application 

and it will continue to function as intended.

In the software mixer, locate the DAW 

channels by pressing the DAW view button 

and increase the level of DAW 1+2 fader.

Double check that iD22 is set as the active 

playback device in your DAW and in OSX:

System Preferences > Sound > Output Tab

> Audient iD22 highlighted as USB playback

Troubleshooting & FAQ

Troubleshooting

•	 I have clocking issues which include 

iD22 not locking to external ADAT                 

devices or operating at the incorrect 

rate compared to my Pro Tools session:

Go to Audio MIDI Setup in OSX, found by 

navigating to the folder:

Macintosh HD > Applications > Utilities > 

Audio MIDI Setup

Ensure that Audient iD22 is seen as an 

audio device (Window Menu, Show Audio 

Window).

Double check that an appropriate clock 

source is selected (Internal for master 

operation), ADAT or S/PDIF clock for 

external slave operation. Ensure that you 

see the correct sample rate displayed in 

the Format drop-down menu.
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Troubleshooting & FAQ

Troubleshooting

•	 How do I reset the iD22 mixer              

application to it’s default state?

To reset the mixer application, close the 

mixer and then navigate to the following 

folder and delete the state.xml file (it will   

replenish upon a fresh launch and closure 

of the application, storing your default     

setup):

Macintosh HD > User > Library > Application 

Support > Audient > iD22 > state.xml

Do not delete the parent folder as this will 

also contain your iD22 mixer presets.

•	 I’m getting random crashes and bugs, 

how do I make sure I have the latest   

version of iD firmware/software?

To check for the latest updates to the

iD desktop mixer application please visit:

www.audient.com/iD22 download the 

package and install.

To update the iD22 firmware to the 

latest version please use the Help 

menu in the application bar and select 

Check for Updates, refer to page 8 in 

this user manual for more information 

regarding firmware update.

FAQs

For more information and bug support,

please search our online Knowledge Base 

which can be found here:

www.audient.com/support

For technical support please create 

a ticket in our online support system, 

Zendesk which can also be found in the 

support section of our website 

(see link above).

 

Specifications

MICROPHONE PREAMPLIFIERS:
(measured to insert send)

ADC LINE INPUTS (Insert Returns):
(measured at optical output under AES-17)

DAC OUTPUTS (1-4):
(measured from optical input under AES-17)

HEADPHONE OUTPUT (5&6):
(measured from optical input under AES-17)

USB2.0 HIGH SPEED:

DIGITAL i/o:

POWER SUPPLY:

D.I (Channel 2):
(measured to insert send)

INSERT SENDS (Mic Pre Out):

MIC GAIN:			  -10 to +60 dB (-10dB Pad)
LINE GAIN:			  -20 to +40 dB (-10dB Pad)
PHANTOM POWER: 		  48v +/-4v @ 10mA/Channel
MIC EIN:			   <-125dBu
CMRR:			   >80dB @ 1kHz
MAXIMUM INPUT LEVEL:	 +22dBu (+32dBu with Pad)
INPUT IMPEDANCE (Mic):	 >3kΩ Balanced
INPUT IMPEDANCE (Line):	 >10kΩ Balanced
FREQUENCY RESPONSE:	 +/-0.5dB 10Hz to 100kHz
CROSSTALK:		  <-90dBu @ 1kHz & 10kHz
THD+N @ 0dBu (1kHz):	 0.0015% (-96dBu)
SNR: 			   96dB
HPF:			   -3dB @ 100Hz, 2nd Order 
			   (12dB/Octave)

XLR: Pin 2 (Hot), Pin 3 (Cold) & Pin 1 (Shield)
1/4” JACK: TIP (Hot), RING (Cold) & SLEEVE (Shield)

MAXIMUM INPUT LEVEL:	 +18dBu
DIGITAL REFERENCE LEVEL:	 0dBFS = +18dBu
INPUT IMPEDANCE:	 	 >10kΩ Balanced
FREQUENCY RESPONSE: 	 +/-0.5dB 10Hz to Fs/2	
CROSSTALK:		  -100dBu @ 1kHz & 10kHz
THD+N @ -1dBFS (1kHz):	 <0.002% (-94dB)
THD+N @ -6dBFS (1kHz):	 <0.0015% (-97dB)
DYNAMIC RANGE: 		  117dB un-weighted
			   120dB A-weighted

1/4” JACK: TIP (Hot), RING (Cold) & SLEEVE (Shield)

MAXIMUM OUTPUT LEVEL:	 +18dBu
DIGITAL REFERENCE LEVEL:	 0dBFS = +18dBu
OUTPUT IMPEDANCE:	 <100Ω Balanced
FREQUENCY RESPONSE: 	 +/-0.5dB 5Hz to Fs/2
CROSSTALK:		  -110dBu @ 1kHz & 10kHz
THD+N @ -1dBFS (1kHz)	 : <0.0008% (-101dB)
DYNAMIC RANGE: 		  110dB un-weighted
			   114dB A-weighted

1/4” JACK: TIP (Hot), RING (Cold) & SLEEVE (Shield)

MAXIMUM OUTPUT LEVEL:	 +18dBu
DIGITAL REFERENCE LEVEL:	 0dBFS = +18dBu
OUTPUT IMPEDANCE:	 <100Ω Balanced
FREQUENCY RESPONSE: 	 +/-0.5dB 5Hz to Fs/2
CROSSTALK:		  --110dBu @ 1kHz & 10kHz
THD+N @ -1dBFS (1kHz)	 : <0.0008% (-101dB)
DYNAMIC RANGE: 		  110dB un-weighted
			   114dB A-weighted

1/4” JACK: TIP (Hot), RING (Cold) & SLEEVE (Shield)

D.I GAIN:			   -16 to +54 dB (-10dB Pad)
MAXIMUM INPUT LEVEL:	 +16dBu (typical), +22dBu
INPUT IMPEDANCE:	 	 1MegΩ Unbalanced
FREQUENCY RESPONSE:	 +/-0.5dB 10Hz to 50kHz
THD+N @ 0dBu (1kHz):	 <0.03% (-70dBu)
SNR: 			   93dB

1/4” JACK: TIP (Hot) & SLEEVE (Shield)

MAXIMUM OUTPUT LEVEL:	 +22dBu
OUTPUT IMPEDANCE:	 <100Ω Balanced

1/4” JACK: TIP (Hot), RING (Cold) & SLEEVE (Shield)

ADAT 8 CHANNELS		  44.1 - 48kHz
ADAT 4 CHANNELS		  88.2 - 96kHZ
STEREO S/PDIF		  44.1 - 96kHz

No. of INPUT CHANNELS	 10 
(2 Analogue, 8 Digital)

No. of OUTPUT CHANNELS	 14
(6 Analogue, 8 Digital)

12VDC Centre Positive DC Adapter - >1.5Amps
Internally conditioned to provide +48VDC, +/-15VDC & 
low voltage rails for digital processing core & converters.
iD22 cannot be bus powered for quality reasons.

http://www.audient.com/iD22
http://www.audient.com/support
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Dimensions
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Warranty

Warranty Statement

Your iD22 comes with a manufacturer’s warranty for one year (12 months) from the 

date of despatch to the end user.

The warranty covers faults due to defective materials used in manufacture and faulty 

workmanship only.

During the warranty period audient will repair at its discretion or replace the faulty unit 

provided it is returned carriage paid to an authorised audient service centre. We will not 

provide warranty repair if in our opinion the has resulted from unauthorised modification, 

misuse, negligence or accident.

We accept liability to repair or replace your iD22 as described above. We do not accept 

any additional liability. This warranty does not affect any legal rights you may have against 

the person who supplied this product - it is additional to those rights.

Warranty Limitations

This warranty does not cover damage resulting from accident or misuse. The warranty is void 

unless repairs are carried out by an authorised service centre. The warranty is void if the unit 

has been modified other than at the manufacturer’s instruction. The warranty does not cover 

components which have a limited life, and which are expected to be periodically replaced for 

optimal performance. We do not warrant that the unit shall operate in any other way than as 

described in this manual.

Audient Ltd
Aspect House
Herriard
Hampshire
RG25 2PN
United Kingdom

Tel: 0044 1256 381944

www.audient.com

http://www.audient.com
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Service Information

iD22 contains no user-serviceable components, please refer to qualified service personnel 

for diagnosis and repair. Your warranty will be void if you tamper with the device at component 

level. If you have any questions with regard to the repair, please contact Audient Ltd.

In the event your iD22 needs to be repaired, it is necessary to contact Audient Ltd prior to

shipping, and a Return Materials Authorization (RMA) number will be assigned. This number 

will serve as a reference for you and helps facilitate and expedite the return process. When 

the unit is returned please include this RMA number along with a description of the fault inside 

the packaging box. Audient requires that shipments be pre-paid (for in-warranty repairs we will 

cover the return shipping).

To request an RMA, access technical support & FAQs, ask for troubleshooting assistance or 

make an enquiry, please visit: www.audient.com/support

Service Glossary

A		  Amperes
ADAT		  Alesis Digital Audio Tape
ADC		  Analogue to Digital Converter
DAW		  Digital Audio Workstation
ASP		  Analogue Signal Processing
ALT		  Alternative
CPU		  Central Processing Unit
CUE		  Artist Headphone Mix
DAC		  Digital to Analogue Converter
dB		  Decibel
dBu		  Decibel referenced to 0.775Vrms = 0 dBu
dBFS		  Decibel Full Scale
DC		  Direct Current
D.I		  Direct Injection (Instrument Input)
DoC		  Declaration of Conformity
DSP		  Digital Signal Processing
EQ		  Equaliser
FAQ		  Frequently Asked Questions
FCC		  Federal Communications Commission
GB		  Gigabyte
GUI		  Graphical User Interface
HPF		  High Pass Filter
HV		  High Voltage
i/o		  Input / Output
JFET		  Junction Field Effect Transistor
LED		  Light Emitting Diode
RoHS		  Restriction of Hazardous Substances
RAM		  Random Access Memory
S/PDIF	 Sony Philips Digital Interconnect Format
THD+N	 Total Harmonic Distortion + Noise
TRS		  Tip Ring Sleeve (1/4” Jack Balanced)
TS		  Tip Sleeve (1/4” Jack Unbalanced)
USB		  Universal Serial Bus
V		  Volts
XLR		  Extra Live Return, Extremely Low Resistance, 
		  Canon X Series, Latching, Resilient Rubber Compound... or make up your own!

http://www.audient.com/support
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